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Getting Started 
Lodging Link™ provides a universal protocol for seamless communication between 
property management systems (PMSs) and guest service systems (GSSs). Lodging Link 
offers quick and simple integration of GSSs such as PBX, voice mail, call accounting, in-
room internet access, point-of-sale, in-room movie, keyless entry, mini-bar, and energy 
management. 
 
Lodging Link PTS (Protocol Translation Software) runs as a service on your Windows 
PC and is managed using an application called LL PTS Monitor. 

Requirements and Setup 

 
WHAT’S 
THAT? 

Your PC must be running a version of Windows that uses services; 
these include Windows 2000, NT, and XP. Windows NT users are 
required to use service pack 6 or higher. Windows 95, 98, and ME do 
not use services and therefore cannot be used with this product. 
 
The Lodging Link PTS CD will automatically run the Setup program 
when you insert it. Follow the prompts to complete the installation. 
 
Once you’ve installed the service, it will begin running automatically. 
If you’ve accepted the default installation settings, you can access LL 
PTS Monitor by clicking the Start menu and selecting Programs, 
Lodging Link PTS. 
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LL PTS Monitor Tour 
 

 

  

6 7 8

 

1. File menu: use to save, print, and send Monitor information. 
2. Edit menu: use to copy information. 
3. View menu: use to clear, pause, or resume the Monitor, and to toggle the 

Toolbar and Status bar on and off. 
4. Font menu: use to increase or decrease the size of the font in the Monitor 

and Filter windows. 
5. Filter menu: use to configure and open new data filtering windows. 
6. Settings menu: use to view and edit port configuration. 
7. Service menu: use to control the LL PTS Service. 
8. Logging menu: use to configure data logging in the LL PTS Service. 
9. Security menu: use to enable password protection for administrative LL 

PTS functionality. 
10. Help menu: use to access information about LL PTS Monitor. 
11. Toolbar: use to perform the following application functions: Save, Copy, 

Print, Increase/Decrease Font, Select Font Size, Clear, Pause, Resume, 
Start/Stop/Restart LL PTS Service, and About. 
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12. Monitor Window: use to view the following information: Network, Device, 
Version, Image, Port, and Service Data. 

13. Status Bar: use to view application status. 
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LL PTS Monitor 
LL PTS Monitor is an application for managing the Lodging Link PTS service. Using LL 
PTS Monitor, you can: 
• View service and system information. 
• Edit port configuration. 
• Edit logging configuration. 
• Manage LL PTS Service. 
• Save and send information. 

Accessing Lodging Link PTS Information 

 
WHAT’S 
THAT? 

LL PTS Monitor will display the following information in the Monitor 
window when started: 

• Network: IP address, subnet, and MAC address of the 
PC the Lodging Link PTS service is running on 

• Device: device name and DMM (device make & 
manufacturer) information for each logical port 

• Version: version information for each Lodging Link PTS 
component 

• Image: image information for Lodging Link PTS 
• OS: operating system information for the PC on which 

Lodging Link PTS is running  
• Port: configuration information for each logical port 
• Service: status of the Lodging Link PTS service when 

opening the application 

To view Lodging Link PTS information: 
1. Launch LL PTS Monitor. 
2. Information about your Lodging Link system will be displayed in the 

Monitor window at the time you launch LL PTS Monitor. 
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Port Configuration 

 
WHAT’S 
THAT? 

The Configuration box is accessed from the Settings menu and 
displays the following information: 

• LP: logical port number 
• Device name: device associated with the logical port 
• Physical port: physical port mapped to the logical port 
• DMM: device make & manufacturer for the device 

associated with the logical port 
• Type: whether the logical port is a serial, UDP, TCP 

client, or TCP server port 
• Settings: baud rate, data bits, parity, and stop bits for a 

serial port; IP address and port number for a UDP or 
TCP client port; port number for a TCP server port 

• Available Physical Ports: physical serial ports on the PC 
that are currently available for mapping to a logical port 
(the logical port’s type must be designated as serial) 

 
These properties may be viewed in the Configuration box, or edited 
by double clicking the logical port.  
 
When changing these properties, the changes will not take effect until 
the Service has been restarted. 

To view port properties: 
1. Click the Settings menu and select Configuration. 
2. A summary of the settings for each logical port as well as the available 

physical ports will be displayed. 
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To edit port properties: 
1. Double click the logical port you want to edit. 
2. For a serial port, click Serial in the Port Type section, and then edit the 

Baud rate, Parity, Data bits, Stop bits, and Flow control as needed. 
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3. For a UDP port, click UDP in the Port Type section, and then enter a valid 
IP Address and Port number. 

 
4. For a TCP Client port, click TCP Client in the Port Type section, and then 

enter a valid IP Address and Port number. 

 
5. For a TCP Server port, click TCP Server in the Port Type section, and then 

enter a Port number. 

LL PTS Monitor  13 



 
6. Click OK to close the Port Settings box. 
7. Click OK to close the Configuration box. 
¾ To cancel your changes, click Cancel in the Port Settings or Configuration 

box. 
8. Click Yes when prompted to restart the service. 

 
¾ You will be prompted to restart only if changes have been made and only if the 

Service is currently running. 

To change a physical port: 
1. Click the physical port you want to use in the Available Physical Ports box. 
2. Drag to the logical port you wish to map the physical port to, and then 

drop. 
¾ The Type must already be set to Serial. 
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Drag 

 Click

3. To remove the mapping, click the logical port and press Delete. 
4. Click OK. 
5. Click Yes when prompted to restart the service. 

 

Pausing and Resuming the Monitor 

 
WHAT’S 
THAT? 

You may pause the LL PTS Monitor at any time. The Lodging Link 
PTS service will continue to run while the Monitor is paused, but data 
coming into it will not be recorded. Once you resume the Monitor, it 
will begin collecting data again from that point. 

To pause and resume the Monitor: 

1. Click the Pause button on the Toolbar to pause the Monitor.  
¾ You can also click the View menu and select Pause. 

2. Click the Resume button on the Toolbar to resume the Monitor.   
¾ You can also click the View menu and select Resume.  
¾ Remember that any data coming through the service while the Monitor was 

paused has not been recorded by the Monitor application. 
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Working with Monitor Files 

 
WHAT’S 
THAT? 

LL PTS Monitor allows the following functions for information in the 
Monitor window: 

• Copy: copy the selection to the Windows Clipboard 
• Print: print all or selected information 
• Save: save information to a text file 
• Send: send information as an attachment to an email 

message 
• Clear: clear the Monitor window; information that has 

not been saved will be lost 
• Filter: display only information that fits specific filter 

criteria 
The Monitor application is intended for short term monitoring of the 
Service message traffic. The Monitor window will show only a 
maximum of 2000 lines of text. For long term monitoring, enable 
Logging to a File by the Service by using the Logging menu in the 
Monitor application. 

To copy Monitor information: 
1. Select the information you want to copy in the Monitor window. 

 

16  LL PTS Monitor 



2. Click the Copy button on the Toolbar.   
¾ You can also click the Edit menu and select Copy, or press Ctrl + c. 

To print the Monitor file: 
1. To preview the file before printing, click the File menu and select Print 

Preview. 
¾ Click the Print button to print from the preview, or Close to exit it. 

 
2. To print a selection, select the text you want to print. 

3. Click the Print button on the Toolbar.   
¾ You can also click the File menu and select Print, or press Ctrl + p. 

4. Change the Print range and Copies settings if desired, then click OK. 

 

LL PTS Monitor  17 



To save the Monitor file: 

1. Click the Save button on the toolbar.   
¾ You can also click the File menu and select Save As. 

2. Specify a file name and location, and then click Save. 

 

To send the Monitor file: 
1. Click the File menu and select Send. 
2. A message will be created in your default email application with the 

Monitor file attached. Address and send the message as you normally 
would. 

 
¾ If the file has not already been saved, it will be attached as Untitled.txt. 

To clear the Monitor: 

1. Click the Clear button on the toolbar.   
¾ You can also click the View menu and select Clear. 
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¾ If you need to retrieve the data, be sure to save it to a file before clearing the 
Monitor. Closing and reopening the LL PTS Monitor application will display 
initial configuration data again. 

 

To Filter Monitor Information: 
1. Click the Filter menu and select Enable…. 
2. To show only information from one or more specific devices, enter the 

DMM values in the DMM text box. 
¾ A maximum of 10 DMM values can be entered with each separated by either 

a comma or a space.  
¾ Data entered in non-DMM format will be ignored, as will any DMM values 

after the first 10 entered.  
¾ If no DMM values are entered, information from ALL devices will be shown. 

3. To filter information based on finding a keyword in the data, enter a 
keyword string in the Keyword text box. 
¾ If one or more DMM values are entered, only information from those devices 

will be searched for the keyword value. 
¾ System messages are not filtered on keywords; only information from devices 

will be searched for keyword matches. 
¾ Keyword strings are searched for in their entirety, partial matches are not 

supported. 

 
4. Choose to either show information containing the keyword or hide 

information containing the keyword by selecting the either the Show or 
Hide radio button below the Keyword text box. 
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5. Choose to either show or hide system messages by selecting or de-
selecting the Show System Messages checkbox. 

6. Click OK. A new Filter Results window will be displayed.  
¾ The Filter Results window will initially contain the results of applying the 

filter to the data from the Monitor main display window. As new information 
is received from the Service, the new information will be displayed in the main 
window and the filtered results will be displayed in the appropriate Filter 
Results window.  

¾ A maximum of eight (8) Filter Results windows may be open at any given 
time, each displaying the results of different filter criteria applied to the data 
in the main display window. 

¾ Pausing the display of new data in the main window also pauses the display of 
new data in the Filter Results windows. 

 

Configure Service Logging Options 

 
WHAT’S 
THAT? 

You can configure logging of the data from LL PTS Service to a text 
file. When logging is enabled, the LL PTS Service will log all data to a 
text file located in the “Logs” directory within the product installation 
directory (by default this is “C:\Program Files\Comtrol 
Corporation\Lodging Link PTS”). The logs are text files that can be 
viewed in any text editor to assist in trouble shooting issues with the 
product, connected devices, and the PMS interface. Once logging is 
enabled, logging by the LL PTS Service will continue until logging is 
disabled, whether the Monitor application is running or not. 
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To Configure Service Logging Options: 
1. Click the Logging menu and select Configure…. 

 
2. To enable logging to a file in the service, select the Enable checkbox. To 

disable logging to a file, de-select the Enable checkbox. 
3. To have the service rename the log file when a maximum file size is 

reached select the Max File Size radio button and enter a maximum size 
(in megabytes) in the Max Size text box. 
¾ The Max Size is limited to a range of 0.1 MB to 20 MB. 

4. To have the service rename the log file when a date cycle has completed 
select the Date Cycle Completed radio button and select either Daily, 
Weekly, or Monthly.  
¾ Selecting Daily will cause the log file to be renamed at approximately 12 

Midnight each day. 
¾ Selecting Weekly will cause the log file to be renamed at approximately 12 

Midnight each Monday morning. 
¾ Selecting Monthly will cause the log file to be renamed at approximately 12 

Midnight on the first of each month. 
5. Click OK.  
¾ The changes to the logging options will take effect immediately if the Service is 

running and the next time the Service is started if the service is not running. 
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Security for Monitor Features 

 
WHAT’S 
THAT? 

Features within the LL PTS Monitor application that are considered 
“Administrative” can be secured by requiring a password to access 
them. Enabling Security allows an application password to be set. 
Once this password is in place, each time a there is an attempt to 
access a protected feature the Monitor application will prompt for the 
application password.  
 
The protected features are Settings Configuration, Service 
Management, Service Logging Configuration, and Security Password 
Management. 

To Enable Password Protection or Change Password: 
1. Click the Security menu and select Password…. 

 
2. Select the Enable Password checkbox. 
3. Enter a new password in the Set New Password text box. 
¾ Passwords must be between 4 and 12 characters in length. 

4. Enter the password again in the Re-enter New Password text box. 
5. Click OK. 

 

To Disable Password Protection: 
1. Click the Security menu and select Password….  
2. Enter the existing password and click OK. 
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3. De-select the Enable Password checkbox. 

 
4. Click OK.
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The Lodging Link PTS Service 
LL PTS Monitor allows you to manage the Lodging Link PTS service. You can also 
manage the service properties directly through Windows. Service management is an 
administrative function of Windows. Specific versions vary; refer to Windows Help for 
information on accessing service management for your specific operating system. 

Stopping and Starting the Service 

 
WHAT’S 
THAT? 

By default, the Lodging Link PTS service will run automatically. 
Should you wish to stop or start it, you can do so from within the LL 
PTS Monitor application.  This should only be necessary when 
making changes to the service configuration or when instructed to do 
so by Comtrol technical support. 

To stop, start or restart the Lodging Link PTS service: 
1. Click Service menu and select Start, Stop, or Restart. 
¾ Stopping the LL PTS Service will terminate communications between 

attached devices and the PMS. During normal operation the LL PTS Service 
should only need to be restarted in order to reload the service configurations. 

2. The Status Bar will show a progress bar to show the progress on starting, 
stopping or restarting the Service. 

¾ You can also click the Stop button to stop the service.  

¾ You can also click the Start button to start the service.  

¾ You can also click the Restart button to restart the service.  
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Troubleshooting and Support 
Technical support is available by both telephone and email. The following pages provide 
timesaving information to maximize your support options. 

Troubleshooting 

 
WHAT’S 
THAT? 

Should an issue arise, you may find you can quickly address it by 
reviewing the common problems and possible solutions below. 
 
If none of these circumstances apply, or you need further assistance, 
refer to the Support section later in this chapter. 

Condition: Data comes through the interface from the device, but the device 
cannot receive any data 
Troubleshooting steps: 

1. This may indicate a baud rate problem; contact the device vendor to verify 
the appropriate baud rate. 

2. Verify that the device was installed completely using the device setup 
instructions. 

Condition: Cannot establish a connection to the PMS 
Troubleshooting steps: 

1. Verify that the port settings (baud rate, parity, stop bits, data bits) are set 
correctly. 

2. Verify that the IP address of the PMS is correctly set. 
3. Verify that the port number is set to the same number that the PMS is 

using when it opens the connection. 

Condition: Lodging Link sends NAKs in response to data received from a 
device 
Troubleshooting steps: 

1. Verify that the device is sending the correct data format and checksum. 
¾ Refer to the device’s vendor to verify this information. 

2. Verify that the device was installed completely and correctly using the 
device’s setup instructions. 
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Condition: Lodging Link does not send any data to a device 
Troubleshooting steps: 

1. Verify that the device is in a “responding” state. 
¾ If Lodging Link determines that a device is not responding, it will send data 

up to three times before timing out. At this point, no further attempts to 
communicate will be made until the device responds first. 

2. Verify that the device is operational. 
¾ If the device is not functioning properly, refer to the device’s vendor to correct 

the problem, and then reboot Lodging Link. 
3. Verify that the baud rate is set correctly. 
¾ If the device is functioning properly and in a responding state, the problem 

may be due to the current baud rate. 

Message List 

 
WHAT’S 
THAT? 

The following is a summary of Lodging Link messages. GSS devices 
will also have their own messages that are not listed here. 

• Received PTISIG_DEVICE_INITIALIZE: 
LL3Library\LGSDevice.cpp DEBUG; the GSS device 
driver has received the watchdog's initialization signal 

• Received PTISIG_DEVICE_GO: 
LL3Library\LGSDevice.cpp DEBUG; the GSS device 
driver has received the watchdog's go signal 

• Timed out waiting for complete packet: 
LL3Library\LGSDevice.cpp DEBUG; a complete packet 
was not received within the GSS device driver's 
specified time frame 

• State mismatch in OnTimeoutWaitingForENQResponse(): 
LL3Library\LGSDevice.cpp DEBUG; the waiting bid 
for line response timer has fired but the transaction 
manager is not waiting for a bid for line response; the 
timer is ignored 

• No packet waiting for timer ‘TimerID’: 
LL3Library\LGSDevice.cpp DEBUG; the waiting data 
response timer, with the specified TimerID, has fired 
but the transaction manager has no packet associated 
with the timer; the timer is ignored 

• State mismatch in OnTimeoutWaitingForDataResponse(): 
LL3Library\LGSDevice.cpp DEBUG; the waiting data 
response timer has fired but the transaction manager is 
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not waiting for a data response; the timer is ignored. 
• Device not responding: LL3Library\LGSDevice.cpp 

WARNING; a packet has been sent to the GSS device 
(possibly several times) and the GSS device has not sent 
any packet back in response 

• Device busy: LL3Library\LGSDevice.cpp WARNING; a 
bid for line sequence has been sent to the GSS device 
and has been NAKed (possibly multiple times); 
Lodging Link is considering this device as unable to 
receive packets and will try sending the packet later 

• Invalid packet: LL3Library\LGSDevice.cpp WARNING; 
a data packet has been sent to the GSS device and has 
been NAKed (possibly multiple times); Lodging Link 
assumes that NAKing of data indicates a badly 
formatted packet; the packet being sent is discarded 

• No packet to resend: LL3Library\LGSDevice.cpp DEBUG; 
a NAK reply received or time out waiting data response 
occurred but the corresponding packet to re-send has 
been inadvertently cleared from the outbound queue 
(indicative of a coding problem) 

• No packet to send: LL3Library\LGSDevice.cpp DEBUG; 
an LGS Device somehow has entered the "Send 
Outbound Data" routine (after being notified that data 
is waiting to go out) but notices that there is no actual 
data that needs sending in the queue (indicative of a 
coding problem) 

• ENQ packet ‘PacketID’ using timer ‘TimerID’: 
LL3Library\LGSDevice.cpp DEBUG; an ENQ packet 
has been created, and a timeout counter initialized (this 
is in preparation for the ENQ to be sent to a GSS device) 

• Data packet ‘PacketID’ using timer ‘TimerID’: 
LL3Library\LGSDevice.cpp DEBUG; a data packet has 
been created, and a timeout counter initialized (this is in 
preparation for the data packet to be sent to a GSS 
device) 

• Sent 'Packet' to port: LL3Library\LGSDevice.cpp 
DEBUG; a data packet was sent to a GSS device (or in 
the event that this message is traced from the PMS 
DMM in the Lodging Link interface, this message is 
indicative of a packet being sent from the Lodging Link 
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PMS interface to the actual PMS device) 
• Begin complete packet timeout ID ‘TimerID’: 

LL3Library\LGSDevice.cpp DEBUG; packet data is 
being received but it has not yet been determined to be 
a complete packet; a timer is initialized and if the 
complete packet is not received before the timer expires 
the data will be cleared from the buffer 

• Received packet 'Packet' from port: 
LL3Library\LGSDevice.cpp DEBUG; an entire packet 
was received from a GSS device and Lodging Link will 
attempt to process it 

• Invalid data format in packet 'Packet': 
LL3Library\LGSDevice.cpp DEBUG; although a 
complete packet was received, the format of data within 
the envelope is incorrect and the message cannot be 
processed 

• Checksum failed, should be 'Checksum': 
LL3Library\LGSDevice.cpp DEBUG; the checksum 
value received within a packet sent from a GSS device 
did not match the checksum that was calculated for that 
packet by Lodging Link; the packet will be cleared from 
the buffer 

• Invalid message from device, message not processed: 
LL3Library\LGSDevice.cpp ERROR; a message 
received from a GSS device was properly formatted, but 
is not a supported message in this interface 

• Unknown processing state: LL3Library\LGSDevice.cpp 
DEBUG; internal coding error that has caused the 
device's processing state to have a value which was 
never expected 

• Unknown transaction state: LL3Library\LGSDevice.cpp 
DEBUG; internal coding error that has caused the 
device's transaction state to have a value which was 
never expected. 

• No timer for ACK packet (inbound waiting ENQ response): 
LL3Library\LGSDevice.cpp DEBUG; timer not properly 
initialized or OS has run out of available timer resources 

• No timer for NAK packet (inbound waiting ENQ response): 
LL3Library\LGSDevice.cpp DEBUG; timer not properly 
initialized or OS has run out of available timer resources 
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• No ENQ packet to resend: LL3Library\LGSDevice.cpp 
DEBUG; ENQ timer has expired and the original ENQ 
packet is unavailable. (Indicative of a coding problem) 

• No timer for ENQ packet (inbound waiting ENQ response): 
LL3Library\LGSDevice.cpp DEBUG; timer not properly 
initialized or OS has run out of available timer resources 

• Received data while waiting for ENQ response: 
LL3Library\LGSDevice.cpp DEBUG; received a Data 
packet while awaiting a line level response to an ENQ 

• No timer for ACK packet with ID ‘PacketID’ (inbound wait 
data response): LL3Library\LGSDevice.cpp DEBUG; 
received an ACK in response to data but there's no 
running timer with the ID associated with the inbound 
ACK 

• No outstanding data packet with ID ‘PacketID’ (ACK): 
LL3Library\LGSDevice.cpp DEBUG; received data after 
sending an ACK to an ENQ, but there's no running 
timer with the ID associated with the inbound data 

• No outstanding data packet with ID ‘PacketID’ (NAK): 
LL3Library\LGSDevice.cpp DEBUG; received data after 
sending an NAK to an ENQ, but there's no running 
timer with the ID associated with the inbound data 

• No timer for NAK packet with ID ‘PacketID’ (inbound 
waiting data response): LL3Library\LGSDevice.cpp 
DEBUG; received a NAK in response to data, but there's 
no running timer with the ID associated with the 
inbound NAK 

• No timer for ENQ packet with ID ‘PacketID’ (inbound 
waiting data response): LL3Library\LGSDevice.cpp 
DEBUG; received an ENQ in response to data, but 
there's no running timer with the ID associated with the 
inbound ENQ 

• Invalid packet ID: LL3Library\LGSDevice.cpp DEBUG; 
bad format for UHLL Packet ID (Message Number) 

• Unknown processing state: LL3Library\LGSDevice.cpp 
DEBUG; internal coding error that has caused the 
device's processing state to have a value which was 
never expected 

• Invalid packet ID (outbound transaction level): 
LL3Library\LGSDevice.cpp DEBUG; GSS Interface has 
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created an invalid UHLL Packet ID (Message Number) 
(indicative of a coding error) 

• No outstanding ENQ packet to resend: 
LL3Library\LGSDevice.cpp DEBUG; waiting ENQ 
response timer fires and no response received to ENQ, 
but no ENQ in queue to resend (indicative of a coding 
problem) 

• No outstanding data packet with ID %ld to resend: 
LL3Library\LGSDevice.cpp DEBUG; waiting data 
response timer fires and no ACK/NAK received, but no 
data in queue to resend (indicative of a coding problem) 

• Sending packet out while waiting for data: 
LL3Library\LGSDevice.cpp DEBUG; Lodging Link was 
expecting a data packet from the GSS device but instead 
received a line level Bid for Line and is replying to it 

• Initialized device ‘Port’: LL3Library\LGSDeviceApp.cpp 
INFO; the interface has opened the specified 
communication port in Lodging Link 

• Could not initialize device ‘Port’: 
LL3Library\LGSDeviceApp.cpp ERROR; there was an 
error when Lodging Link attempted to open the 
specified port 

• Deinitialized device ‘Port’: 
LL3Library\LGSDeviceApp.cpp INFO; the interface has 
closed communication for the specific port in Lodging 
Link 

• Received Message from router: 
LL3Library\LGSDeviceApp.cpp DEBUG; a device 
interface has received a UHLL message 

• Killing timer ‘TimerID’ in EndCompletePacketTimeout(): 
L3Library\LGSDeviceApp.cpp DEBUG; Lodging Link 
has timed out while waiting for a complete packet; 
indicates the appropriate timer has been killed 

• Killing timer ‘TimerID’ in EndENQResponseTimeout(): 
LL3Library\LGSDeviceApp.cpp DEBUG; Lodging Link 
has timed out while waiting for a line level response to 
an ENQ which was previously sent from Lodging Link 
to the device; indicates the appropriate timer has been 
killed 

• Killing timer ‘TimerID’ in EndDataResponseTimeout(): 
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LL3Library\LGSDeviceApp.cpp DEBUG; Lodging Link 
has timed out while waiting for a complete data packet 
after responding to an ENQ from a device with an ACK; 
indicates the appropriate timer has been killed 

• Killing timer ‘TimerID’ in EndHeartbeatTimer(): 
LL3Library\LGSDeviceApp.cpp DEBUG; Lodging Link 
has timed out while waiting for a response to a 
heartbeat message; indicates the appropriate timer has 
been killed 

• Killing timer ‘TimerID’ in EndTimer(): 
LL3Library\LGSDeviceApp.cpp DEBUG; Lodging Link 
has timed out waiting for a response to either a Data 
packet or an ENQ 

• Data 'Data' cleared from buffer: 
LL3Library\PacketManager.cpp DEBUG; the specified 
data (a partial packet or junk data) is being cleared from 
the buffer; this occurs when Lodging Link has timed out 
waiting for a complete packet 

• Received PTISIG_DEVICE_GO: LL3Library\Parser.cpp 
Received DEBUG; a GSS interface has received 
confirmation that the start up sequence has finished and 
communication with the GSS device may begin 

• No outstanding packet for timer ID ‘TimerID’: 
LL3Library\TransactionManager.cpp DEBUG; Lodging 
Link has timed out waiting for a response from a GSS 
device but has no packet associated with this timer 

• Message router PID is not available (AddLGSDevice): 
LL3AuxLibrary\MessageRouter.cpp ERROR; the 
message router task is not ready to accept UHLL 
messages; most likely caused by a coding problem, 
hardware fault, or out of memory condition 

• Message router PID is not available (RemoveLGSDevice): 
LL3AuxLibrary\MessageRouter.cpp ERROR; the 
message router task is not ready to accept UHLL 
messages; most likely caused by a coding problem, 
hardware fault, or out of memory condition 

• Created shared router data module: 
MessageRouter\MessageRouter.cpp INFO; the message 
router task’s shared data block has been successfully 
created 
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• Could not map shared router data module: 
MessageRouter\MessageRouter.cpp ERROR; the 
message router task’s shared data block was not 
successfully created; most likely caused by a coding 
problem, hardware fault, or out of memory condition 

• Could not load shared router data module: 
MessageRouter\MessageRouter.cpp ERROR; the 
message router task’s shared data block was not 
successfully created; most likely caused by a coding 
problem, hardware fault, or out of memory condition 

• Could not initialize UHLL message list: 
MessageRouter\MessageRouter.cpp ERROR; the shared 
data block containing UHLL message information was 
not successfully created; most likely caused by a coding 
problem, hardware fault, or out of memory condition 

• Could not initialize base class application: 
MessageRouter\MessageRouter.cpp ERROR; the 
message router task was not successfully created; most 
likely caused by a coding problem, hardware fault, or 
out of memory condition 

• Device Port attached: 
MessageRouter\MessageRouter.cpp INFO; a device 
interface has successfully connected to the specified 
logical port 

• Device Port detached: 
MessageRouter\MessageRouter.cpp INFO; a device 
interface has successfully disconnected from the 
specified logical port 

• Received message type ‘MessageType’: 
MessageRouter\MessageRouter.cpp DEBUG; a device 
interface has received the specified UHLL message type 

• No messages waiting for device ‘Port’: 
MessageRouter\MessageRouter.cpp DEBUG; a UHLL 
message was received by the message router but was 
not in the appropriate list (indicative of a coding 
problem) 

• Couldn't find DMM ‘DMM’ in router table: 
MessageRouter\MessageRouter.cpp WARNING; a 
UHLL message destined for the specified DMM was 
received by the message router, but there is no GSS 
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device with that DMM in the Lodging Link system 
• Empty message waiting for TransID ‘TransID’: 

MessageRouter\MessageRouter.cpp WARNING; a 
request UHLL message should be waiting for a 
response, but there was no request message; this 
indicates a coding problem because the message was 
accounted for but cannot be found 

• No device waiting for message with TransID ‘TransID’: 
MessageRouter\MessageRouter.cpp WARNING; a 
UHLL response message was received by the message 
router with the specified transaction ID, but no request 
message could be found; this can be caused by incorrect 
device behavior, incorrect coding, or a timeout period 
expiring which causes the request message to be purged 
from memory 

• Sent 'Message' to DMM ‘DMM’ (unsolicited): 
MessageRouter\MessageRouter.cpp DEBUG; the 
specified message was sent to the specified DMM from 
the message router 

• Checking PMS connection: Derivations\PMSDevice.cpp 
WARNING; Lodging Link expected a response from the 
PMS and has not received it; Lodging Link then sends a 
UHLL (21) ARE YOU THERE message 

Image Updates 
 

WHAT’S 
THAT? 

Image updates may be requested from technical support via the 
Comtrol website. You will receive email notification when your 
image is ready; the message will include a link to the file. 

To update your image file: 
1. Open the email notification from Comtrol and click the link to the image 

file. 
¾ The image file will be a self-extracting archive. 

2. Download and extract the files to a temp directory. 
3. Double click the Setup file to run it. 
4. Follow the prompts to install the new image. 
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Support 

 
WHAT’S 
THAT? 

Hospitality Product Technical Support is available by the following 
means: 

• Email: HPDSupport@comtrol.com; a support 
representative will respond to your request within 4 
hours 

• Telephone: (USA) 480-609-1571; 8:30 AM – 4:30 PM MST* 
 
You are entitled to free technical support as part of your one-year 
product warranty. After the first year, you can continue to receive 
free support as part of your annual maintenance package. Contact 
your Comtrol sales representative for more information on annual 
maintenance. 
 
Before you contact Comtrol, please have detailed Lodging Link PTS 
information ready, including Network, Device, Version, Image, Port, 
and Service information, as well as a detailed log file that displays the 
problem. 
 
* Comtrol operates on Arizona time, which is always MST or GMT -7; Daylight Saving Time 
is not observed. The time is equivalent to US Mountain Time during Standard Time, US 
Pacific Time during Daylight Saving Time. Daylight Saving Time is in effect from the first 
Sunday in April to the last Sunday in October in the United States.  

To access and capture information: 
1. Open LL PTS Monitor. 
2. Scroll through the window to display version and image information. 
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3. For email support, copy and paste the information into your message, 
along with a detailed description of the problem. 
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